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Purpose and scope of this document 

Purpose and scope of this document 
This User Guide briefly describes the general principles of document management in Archie 
(the IMS server) and then moves on to provide more detailed practical advice on managing 
reviews and your module text during Phase 2 of the new IMS. The Guide assumes that you 
have made the initial move to Phase 2 during a site visit with your IMS Support person, and 
that you are now actively using Archie and RevMan 4.3 to manage titles, protocols, reviews, 
and your module text. It also assumes that you have a basic working knowledge of both 
Archie and RevMan; thus, it does not describe every action in full detail. 
 
This initial version of the Guide (1.0) focuses on using Archie and RevMan 4.3 during what 
might be called an ‘interim’ period, during which: 

• Review authors are not yet using the new IMS to manage their reviews and will 
generally not do so until RevMan 5 is released. 

• Archie’s workflow/tracking functionality has not yet been implemented. 
• You will need to continue using the Titles Manager website to register titles until the 

systems for replacing Titles Manager are fully in place. 
 
The Guide will be updated and expanded as developments warrant. 

Other resources

1. Archie’s Help file - accessed from the Help menu in Archie. 
2. User Guide for Phase 1 (on managing contact details) – as a Phase 2 user, you should 

now be managing your contact details in accordance with the User Guide for Phase 1 
so that Archie contains up-to-date contact information for all your authors, editors, 
and CRG editorial base staff. 

3. The IMS bulletins for CRG Super Users (archived at www.cc-
ims.net/Projects/newIMS/Bulletins/). 

4. Your IMS Support person. 
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General principles 

General principles 
Archie has been designed to make it easier for CRGs and other Cochrane entities to manage 
the editing and publication of multiple documents. In relation to the way your Group has 
worked up until now, the principal changes involved in moving to Phase 2 are: 

• Archie now acts as your Group’s shared drive/database for storing and sharing 
reviews and other documents. 

• Archie replaces ModMan entirely and is used to manage the publication of reviews 
and other documents. 

• RevMan 4.3 is used only for retrieving and editing reviews, and not for managing or 
storing them. 

• Archie will eventually take over the function of the Titles Manager website (though it 
does not fully do so yet). 

 
We hope the procedures recommended in this Guide will suggest ways of working that you 
will find useful. Some of the benefits to you as an RGC are: 

• You always know which version of a document is the latest, and where it is. 
• You automatically retain every single version (until you decide you no longer need 

them). 
• Anybody who should have access to a document can do so at any time, as long as 

they have Internet access. 
• Your data are stored safely (see ‘Prevention of data loss’ below).  

 
This section outlines the general principles of document management in Archie. Later 
sections describe in greater detail how to work with specific types of documents, such as 
reviews. Basic terms used in this section and throughout the User Guide are briefly defined in 
Appendix A. 

What is a document in Archie? 

‘Documents’ in Archie include the full range of things listed under ‘Documents’ and 
‘Reviews’ in the Resources tree view. At present, these include:  
• Module text (under ‘Documents’ in the Resources tree view) 
• Vacant Titles, Registered Titles, Protocols, and Full reviews (under ‘Reviews’ in the 

Resources tree view).  
You can also use Archie to store other files in your Documents folder, but this is presently not 
covered in this User Guide. See ‘About generic documents’ in the Help file for more 
information about this feature. 

A note on terminology 

In this User Guide, the term ‘review’ (lowercase) is generally  used to described a Cochrane 
review regardless of its stage, whereas when we are referring to a specific stage, we will be 
using the terms Title, Protocol and Full Review.  We hope it will be clear when we are 
referring to the Full Review only, and when we are using the term ‘review’ more generally to 
include any stage. See Appendix A for a full Glossary of terms. 
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Document Properties 

Every document in Archie has a set of Properties that can be viewed and modified on its 
Properties sheet. The range of information included in the Properties sheet varies depending 
on the specific type of document (for example, a review has more attributes than the module 
text), but always includes the document’s title, its publication status, its availability for check 
out, a list of people with specific roles in relation to the document, and a detailed history of 
the document’s various versions.  
 
To open a document’s Properties, simply double-click the document’s title in the Resources 
tree view, or right-click and choose Properties. 

Document versions 

Typically when you save a document in a word processor, or other software, the previous 
version is overwritten – unless you save it with a new name every time. In Archie, documents 
are versioned, meaning that whenever you save the document, it is automatically saved as a 
new version. All previous versions of a document are listed on the History tab of the 
document’s Properties sheet. 

Version attributes 

A version in Archie has five major attributes (the name of the document itself is shared by all 
versions): 
• Version number – this keeps track of the order of versions. A higher number means a 

more recent version. Version numbers in Archie are in two parts, for example, ‘2.14’, 
where the number before the period is increased each time the document is published, and 
the ‘decimals’ signify draft versions (see example below). The initial version number for 
a document is 0.0. (Currently, an exception is that Generic Documents start as 1.0).  

• Version date – the date the version was created. 
• The version publication status - whether the version is a draft, has been marked or 

submitted for publication, or is published. (Generic Documents cannot be published from 
Archie and do not have this attribute). 

• Version description – this can be used to describe what is unique about each version. 
Version descriptions are sometimes generated by the system (for example, “For 
publication”), but generally they need to be entered by a user. Super Users can modify 
existing descriptions. 

• A person – the person who created a version is always recorded.  
 
Review versions have three additional attributes: 
• Title – the review’s overall name in Archie will be the current title, but each version will 

record the title the review had when that version was created.   
• Stage – Vacant Title, Registered Title, Protocol or Full review.  
• Phase – Authoring or Editorial. 
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Publishing documents 

Many of the documents in Archie are meant for publication in The Cochrane Library or 
elsewhere. Publication of a document from Archie takes place in two steps: 

1. First a user marks the document for publication within Archie, using the Publication 
Wizard (described in greater detail for each type of document, below). This creates a 
special version of the document with the description ‘For publication’. Users can then 
check the document out, make further changes, and check the document back in as a 
new draft version without affecting the version marked for publication.  

2. At regular intervals, the versions marked for publication will be delivered to the 
relevant publisher. For the module text and reviews this will happen on the 
announced deadlines for submissions to The Cochrane Library. If, at the time of the 
deadline, there is no new version marked for publication, the most recent published 
version will automatically be published again. 

 
Publication status is shown in two ways in Archie: 

• Each version of a review and of the module text has a status that reflects whether it is 
a draft, has been marked or submitted for publication, or is published. The versions 
are listed on the History tab of the document’s Properties, where their publication 
status is indicated using a combination of icons (see Figure 1) and text descriptions 
(see “Viewing a document’s history”, below). 

• The overall publication status of a review is indicated in the subfolders of the 
Reviews folder under Resources (for example, the Protocols folder) using the same 
icons (See Figure 1). (Note: The overall publication status of the module text is not 
displayed in this way.) 

Figure 1. Publication status progress and icons 

 
Legend to Figure 1: 
Icon Review folders usage History tab usage 
a. Draft Shown in a separate column when 

the latest version is a draft. 
Used for draft versions. 

b. To be 
published 

Used for reviews where a new 
version has been marked for 
publication, awaiting submission on 
the next deadline. 

Used for versions that have been 
marked for publication, awaiting 
submission on the next deadline. 

c. Submitted for 
publication 

Shown for reviews that have been 
submitted to the publishers, 

Used for versions that have been 
submitted to the publishers, 
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awaiting publication in The 
Cochrane Library. 

awaiting publication in The 
Cochrane Library. 

d. Published Shown if a published version exists, 
and no later version has been 
marked or submitted for 
publication. 

Used for versions that have been 
published. 

e. To be 
republished 

Shown when a published version 
exists, and a later version has been 
marked for publication. 

Not used for versions. 

 

Viewing a document’s history 

A history of the various versions of a document can always be viewed under the History tab 
of the document’s Properties. An example of such a document History is provided in Figure 
2, below. 

Figure 2. Document history showing version numbering, descriptions, and 
publication status 
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The image used in Figure 2 was taken prior to the publication deadline for Issue 3, 2006, of 
The Cochrane Library. Version 6.0 of the review has been marked for publication, and its 
icon shows that it has the ‘To be published’ status. Since this is not the first version of the 
review being published, the overall status of the review is ‘To be republished’, which is 
shown with an icon in the Resources view. See ‘Publishing documents’ above for more on the 
publication status icons. The status panel below the list of versions will show the details for 
the selected version. (Note that this review’s history reflects that it is being published with 
updated author contact details, using the procedure described in ‘Special cases’ below.) 
 
In Figure 3, the user has scrolled down and clicked on version 4.0, and it can be seen that this 
version was first published in Issue 4, 2005, of The Cochrane Library, and that this particular 
version was last published in Issue 1, 2006.  

Figure 3. Details for a previously published version 

 
The version highlighted in Figure 2 is in the ‘Authoring phase’, while the one in Figure 3 has 
the Phase ‘Editorial (shared)’. See ‘Authoring versus Editorial phase’, below, for more on 
review phases. 

Comparing versions 

You can compare two versions at a time to identify differences between them. Differences are 
highlighted in red and green; deleted text is shown in red and with strikethrough; inserted text 
is shown in green and underlined. 
 
To compare two versions, on the History tab, click the first of the versions to compare. It 
becomes highlighted. Then Ctrl-click the other version to compare. It is now also highlighted. 
Click Compare. The document text will open with changes highlighted in red or green. 
 
You can save the compared text as an HTML file using the Download option (disk icon 
button), or create a PDF version by printing it to your PDF generation software (such as 
pdfFactory).  
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Reverting to a previous version 

Archie works from the principle that the most recent version is the best version. This means 
that when you check out a review, or mark it for publication, these actions will always use the 
most recent version. 
 
Note: It is the action of marking a review or module for publication using the Publish 
function that uses the latest version. The actual publication always uses the version explicitly 
marked for publication, regardless of whether a later draft exists. 
 
It may happen that the latest version is not the best version, for example if a wrong version 
was checked in error, or if it is decided that all recent changes should be undone. Or it may be 
that you need to republish a review using the latest contact details in Archie (see ‘When 
authors’ contact details are updated’, below), but that the latest version is a draft that you do 
not want to publish yet. In such cases you can revert to a previous version.  
 
To revert to a previous version, click the version so it is highlighted and click Revert to. This 
will create a new latest version that is identical to the one you reverted to.  
 
Remember to also revert back to the correct version if this is appropriate; for example, if you 
reverted to an earlier version only to republish the current publication with the latest contact 
details in Archie because the latest version is not ready for publication. 

Deleting versions 

Generally, you should not worry about deleting versions, as there is enough room on the 
server for storing lots of versions of each document. For now, rather than risking deleting a 
version you later realise you did need, simply retain all versions. But if there is a version of a 
document that you feel it is important to delete, you can do so, as long as it is not the latest 
version.  
 
To delete a version, highlight it and click Delete. 
  
If the version you wish to delete is the latest version, you must first revert to the correct 
version (see above) before deleting. 
 
Tip: You might find it helpful in the future if you add a note to the review to explain why 
there is a version number missing. 

Document roles 

Document roles link specific people with specific documents and give those people certain 
access rights to the document. The permissions given (for example, to read or edit) are 
determined by the role. In addition to the two roles included in RevMan, Contact reviewer 
and Co-reviewer (these are Contact author and Co-author in Archie), Archie includes several 
other Document roles that can be assigned to people in relation to reviews (for example, 
Contact editor or Referee). Editorial rights to the CRG module text can also be assigned to 
specific people by assigning them the Document role Module Editor. The available Document 
roles, and the specific rights associated with each of them, are described in Appendix B. 
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Document roles are assigned and edited under the People tab of the document’s Properties. 
Only Super Users can assign Document roles in Archie. 

Check in/out 

As stated above, one of the changes introduced by the new IMS is that Archie now acts as 
your Group’s shared drive/database for storing and sharing reviews and other documents. 
When you want to edit a document, you need to check the document out from Archie, edit it, 
then check it back in to Archie. While the document is checked out to one user, it is not 
available for check out to another user. This is an essential part of Archie’s version control 
system. 
 
Note: When you open the module text for editing in Archie (using Edit), the underlying 
mechanism is that the document is checked out to the Module Editor. This means that others 
cannot edit it at the same time, and this in turn means that it is important that the module is 
correctly checked back in when you are done (using either Save document and exit or Discard 
changes and exit). See ‘Editing the Module text’ below. 

Prevention of data loss 

Data stored in Archie are protected against accidental loss in several ways: 
• User action safeguards - the versioning system means that saving a new version of a 

document does not overwrite the previous one. Deletions require confirmation and may 
not be possible if important links to other resources exist.  

• Protection from disk failure - the servers running Archie store all data on two separate 
hard disks. In the rare event that one of the hard disks should suddenly break down, the 
system can continue working without problems while the faulty disk is replaced. 

• Backup - the full database is backed up to a separate physical location every 24 hours. 
Each backup file is kept for a minimum of one week. After a week, only one file per week 
is kept, and for files older than a month, one file per month is kept.  

Please note that backup files are kept to make it possible to restore data in the event of a 
system error or failure. Restoring data from backups is time-consuming and may not be 
appropriate in case of minor user errors. 
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Working with reviews in Archie 
The section on ‘General principles’, above, outlines the basic differences in the way you will 
be working with documents in the new IMS compared to the way you have worked up until 
now. In relation to the management of reviews, the most important differences are:   
• You will now use Archie (and not RevMan or a shared network drive) to store and share 

your Group’s draft and published reviews. The versioning system in Archie will ensure 
that you are always working with the latest version of a review. You will also be able to 
retrieve earlier versions, if need be. 

• You will now use RevMan (in the new version, 4.3) only as a temporary work space for: 
- Editing reviews. 
- Exporting RevMan files to send to review authors (interim period only). 
- Importing RevMan files received from authors for checking in to Archie 

(interim period only). 
• You will now mark reviews for publication using Archie (not ModMan). 
• You will now register titles/create new reviews in Archie. For a time, you will also need 

to continue using the Titles Manager website, but Archie will soon replace this. 

The Resources tree view of Reviews 

The Reviews folder under Resources is where you can find all your reviews. There are 
separate folders for each stage: Vacant Titles, Registered Titles, Protocols, and Reviews. The 
topmost Reviews folder shows the total number of documents in each folder, and how many 
of these are Active, Withdrawn, and Inactive. Within each folder, withdrawn and inactive 
protocols and reviews are listed separately after active protocols and reviews. Moving from 
left to right in the Resources tree view, the various columns display the title of the review, the 
contact author, the review number (if used), the publication status, whether the latest version 
is a draft, whether the review is in the Authoring or Editorial phase, whether the review is 
available for check out, the date last modified, and the review’s general status (Active, 
Withdrawn, or Inactive). You can click any column heading to sort on that column. Click a 
heading again to switch between ascending and descending sort order (shown by the grey up- 
or down-arrow). You cannot currently specify which columns are displayed for each resource 
type, but this is a planned addition. 
  
TIP: The three columns that contain only icons are by default as narrow as possible. This 
makes it difficult to activate sorting on that column. To make it easier to do this, first make 
the column wider by clicking and dragging on the heading’s boundary. 
 
TIP: If you have made changes that are not immediately reflected in the Resources tree view, 
you can use View > Refresh to update the view for a folder. 

Using the right-click menu 

A number of actions can be performed or initiated using Archie’s right-click or ‘context’ 
menus. The options available in these menus depend on the type of resource, and, to some 
extent, the context in which the resource appears. The following table summarizes the options 
available in the menu you get when you right-click the title of a review under Resources.  
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Menu option Action 
New Used to create a new Person or Review (initiates the appropriate 

Wizard).  
View Allows you to view the latest version, or latest published version, of a 

review. 
Print Allows you to print the latest version, or latest published version, of a 

review. 
Download (XML 
format) 

Allows you to download a copy of the document without checking it 
out. Note: Use with caution. In principle this corresponds to using the 
read only (R/O) option when checking out from RevMan, but if you 
open the downloaded file in RevMan, RevMan will not be aware that 
the review has not been checked out, and will use the standard blue 
icon.  

Check Out (XML 
format) 

Checks out the review from Archie as an .r4x file. This file will open 
directly in RevMan 4.3. RevMan 4.2 cannot open these files. 

Check In (XML 
format) 

Checks in a .r4x file exported from RevMan 4.3. 

Delete Allows user to delete all versions of a review. Opens the Delete 
Document Wizard, which displays various Conflicts and Warnings (if 
any). Cannot delete document until Conflicts are resolved. 
Marks the latest version of a review for publication in The Cochrane 
Library (initiates the Publication Wizard). 

Publish 

Unpublish Allows you to undo the Publish action. Removes the For publication 
status for any draft currently marked as such.  

Undo Check-out Resets the review’s Availability to Not checked out. If changes have 
made to the version that was checked out, these will be lost.  

Select Adds the review to your Selection set.     
Deselect Removes the review from Selection. 
Reports  Allows you to view the review’s Document report or Validation report 
Properties Opens the review’s Properties sheet. 

Review Properties  

Every individual review has a Properties sheet, which can be opened by double-clicking the 
title of the review in the tree view or by right-clicking and choosing Properties. The review 
Properties sheet summarizes a great deal of information about the review under the following 
tabs: 

• General – includes Title, Stage, Phase (Authoring versus Editorial), publication and 
modification information, and availability for check out. 

• People – indicates which people have been assigned specific Document roles in 
relation to the review. 

• Topics – displays links to the Group’s Topics list. 
• History – details the history of the review, listing the current version and all previous 

versions. 
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• Advanced – displays information about the review’s status (Active, Withdrawn, 
Inactive), Next Stage Expected, etc. 

• Notes – similar to the notes on person Properties. 

Editing a review’s Title 

If you need to edit the title of a review, this should be done in Archie while the review is not 
checked out. To edit the title, open the review’s Properties, modify the Title on the General 
tab and click Apply. You will be asked to confirm that you wish to change the title, and if you 
click OK, a new version will be created with the description ‘Title changed’. Note that the 
review’s title is recorded for each version, so you can see the titles of previous versions in the 
review’s History.  

Changing stage from Title to Protocol to Review 

The stage of a review (Title, Protocol, or Review) can be set both in RevMan and in Archie. 
Note that even though the stage may have changed in the RevMan file (for example, from 
Protocol to Review), it will change in Archie only when the new file is checked in for 
editorial approval, i.e., only when the Phase changes from Authoring to Editorial (see 
immediately below). This means, for example, that if you check the first draft of a full review 
in to Archie as a draft in the Authoring phase, the title of that draft review will still appear in 
the Protocols section of the Resources tree view. Depending on how your Group has worked 
in the past, this may (or may not) represent a bit of a change. 
 
In Archie, Super Users can change the Stage on the General tab of the review’s Properties. 

Authoring versus Editorial phase 

The Authoring and Editorial phases are special attributes for reviews and their versions that 
control who can edit the document and view each version. The Authoring phase means that 
only people with the document roles Contact Author or Co-author (and, in the interim phase a 
Group’s Super Users) can edit the review, while the Editorial phase gives access to 
individuals with all the other document roles. 
   
Since authors are not currently using the system, this aspect of the two phases does not play a 
major role yet. But some of your authors might be using the system in their role as, for 
example, Editors in another Group, and could potentially attempt to check out their own 
reviews, even though you have not instructed them to do so. 
 
Using the proper review phase is therefore important for the following reasons: 
• It will become a central aspect of managing access to reviews in the future. 
• It may already affect some people’s access. 
• It provides a form of basic tracking, showing whether the authors or the editorial team are 

currently supposed to be working on the review. 
• Reviews must be in Editorial phase to be published. 

Overall review phase and version phases 

A review has an overall phase that determines who can edit it (i.e., check it out and back in), 
but in addition, each version has a separate phase that determines who can view that version.   
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The review’s overall phase is displayed in the Resources tree view and on the General tab of 
the review’s Properties. The version phase determines what versions an individual user can 
view, and thereby also which versions they can compare. 
 
Example: A review that is in the Editorial phase can only be checked out and back in by 
editorial users, and whenever an editorial user checks the review in, the version created will 
have the version phase Editorial. Such versions cannot be viewed by authors, so if an author 
decides to view the review’s History, she cannot see the most recent versions (which in this 
example are editorial drafts), but only those version with an Authoring (or Shared, see below) 
version phase. 

Shared versions 

Versions that have changed from Authoring to Editorial, or the opposite, will have the 
additional phase attribute Shared. This allows persons from both groups to view (but not 
check out) the version. Without this attribute, authors would not be able to see the versions 
they just submitted, because the versions would have moved to the Editorial phase.  
Note: this has no real impact until authors begin using the system. 

Assigning Document roles 

As described above, Document roles link specific people with specific reviews and give those 
people access rights, which vary depending on the particular role. Archie allows CRG Super 
Users to assign Document roles such as Contact author, Co-author, Contact editor, and 
Referee in relation to reviews. The full list of Document roles and the permissions associated 
with each are described in Appendix B. 
 
Document roles may be added, edited, or deleted on the People tab of a review’s Properties. 
 
Assigning the role Contact author is one of the steps involved in creating a new Title in 
Archie (see below). In those cases where you do not create a new Title in Archie, but rather 
check an existing protocol or review in to Archie for the first time, the system will attempt to 
assign Contact author and Co-author roles based on the information contained in the RevMan 
file (see below). You should check the assignments made in this way on the People tab of the 
review’s Properties to make sure they are correct.  

If changes to document roles are made in RevMan 

An important principle of the new IMS is that, whenever possible, changes should be made 
centrally in Archie. This principle naturally also applies to review attributes such as the  
Document roles and contact details, and whenever you at the editorial base need to modify 
these, you should do so in Archie. 
 
But since RevMan 4.2 and 4.3 allow users to modify the ‘Reviewers’ assigned to reviews, 
you will most likely occasionally receive reviews where authors have been added or removed. 
When you check in a version with different authors than those currently in Archie, Archie 
will try to correct the author roles to match those contained in the RevMan file being checked 
in (see Appendix C, ‘Details of how contact details are used in Archie and RevMan’, for more 
information on how Archie handles such cases). If there have been changes to authors, this 
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will be reflected in the report you see after a review has been checked in. It is important that 
you read the check-in report carefully and follow up any information to avoid possible errors 
in the future. There are two problems that can occur, and that you therefore need to look out 
for: 

• A new person record created could be a duplicate. If an author that already has a record in 
Archie has been added in RevMan, but with differences in the spelling of the name and 
email, Archie will not be able to match the two records, and will create a duplicate record. 
The record created will not be marked as a duplicate; this has to be done afterwards. 

• A new author document role is assigned for the review, without the person also getting 
the Entity role Author. Document roles and Entity roles are not automatically correlated, 
so when a person that already exists in Archie becomes linked to a review, this does NOT 
mean that the person also will be given the Author role in your Group. 

You can see a full list of what to watch out for in the check-in report under ‘Checking in 
reviews’ below.   
 
Note: Archie will only update the Document roles for a review if the person checking the 
review in has the relevant permissions. If your editors or authors begin using RevMan 4.3, 
and a user without the permission to assign authors checks in a review with change in the 
authors, Archie will accept the review, but not modify the Document roles. Users’ 
permissions are controlled by their Document or Entity roles. See Appendix B for a list of the 
current permissions for each Document role.  

Linking reviews with Topics 

You can link a review to one or more topics in your Group’s Topics list either from the 
Topics tab of the review’s Properties or from the Topics list itself. You may wish to link to 
topics when you create a new title/review, but you do not have to do this until the first 
protocol version is ready to be published.  
 
To add a link to a topic from the Topics tab of the review’s Properties, click the Select... 
button. This opens a window showing your Group’s topics list. Navigate to the desired topic 
(currently you can only link to topics at the lowest level in the tree), click it so it is 
highlighted, then click Select. 
 
To remove a link to a topic, click the topic so it is highlighted, and click Unselect. 
 
For information on working with the Topics list itself, see ‘Editing the Topics list’ below.  

Review versioning 

Primary versions  

With the new IMS, the old primary/secondary version distinction has changed. The “primary 
version” is now always the most recent version in Archie. The only time you will have the 
primary version of a review in RevMan is when you have checked it out from Archie and 
have not yet checked it back in.  
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Note: RevMan 4.3 shows read-only versions (see below) using the grey icon previously used 
for secondary versions. 

Version numbers and descriptions 

See under ‘General principles’, above, for an explanation of how version numbers are 
assigned. 
 
Version descriptions for reviews are typically entered when the review is checked in to 
Archie from RevMan 4.3. But there are also cases where these descriptions are automatically 
generated: 
• All versions of reviews published before a CRG moved to Phase 2 have been imported 

from the Parent Database and have been labelled according to their publication status: 
‘First Published version’, ‘First review version’, ‘Edited’ ‘Minor update’ and  
‘Substantive update’. 

• Running the Publication Wizard creates a version with the description ‘For publication’.  
• When you revert to a previous version, the new version created is labelled ‘Reverted from 

version [no.]’ 
• If you edit a review’s title, the new version created has the description ‘Title changed’. 
 
Tip: Since information such as the person checking in the version and the date it was done is 
automatically recorded for each version, you do not have to also enter this in the version 
description.  

Setting the Next Stage Expected 

The Next Stage Expected attribute, on the Advanced tab of a review’s Properties, is primarily 
relevant for protocols, since this information is published in The Cochrane Library in the 
‘Review expected to be published in’ section of the Cover sheet. If you wish to use the 
attribute for internal tracking, you can also set it for titles or full reviews, but you do not have 
to. It is currently not resolved how, or whether, this attribute will be integrated with the 
workflow system. 
  
Note: The Next Stage Expected information in Archie is NOT linked to the “Date next stage 
expected” field in the Title window in RevMan, which means that modifying the information 
in one field will not affect the other. The Next Stage Expected in Archie has been set for a 
number of reviews based on the following principles:  
• For previously published protocols and full reviews uploaded to Archie by the IMS team 

at the time of your move to Phase 2, the Next Stage Expected issue number and year in 
Archie are based on the information provided for each protocol and review in the “Issue 
review expected to be published” field in ModMan. 

• For protocols and reviews checked in to Archie after your initial move to Phase 2, you 
will need to set the Next Stage Expected issue number and year manually on the 
Advanced tab of the document’s Properties. 

 
Tip: The Next Stage Expected field can be used in Advanced Searches for reviews. 
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Creating a new Title/Review 

Once you have approved registration of the new title, you should create a new Registered 
Title in Archie. This will create a RevMan file that can be checked out and emailed to the 
authors. Once the Tracking functionality has been added to Archie, creating a Title will also 
initiate tracking of the review. 
 
To create a new Title, use the Review Wizard (File > New > Review): 

• On the opening screen of the Wizard, choose Create a Registered Title, then click 
Next. 

• Select your CRG (this will normally be the only option available) and click Next. 
• Enter the new Title and click Next. The Wizard will search for potential duplicates, 

but, as noted above, this search will not be complete; you will need to continue to use 
the Titles Manager website for checking across CRGs. Click Next. 

• Assign a Contact author (mandatory) and Co-authors (if available). To do this, select 
a Document role from the pull-down list, select a Person, and click Add. Repeat as 
necessary. If the person you are looking for does not have a record in Archie, you will 
need to cancel the Review Wizard and create a record for the person (File > New > 
Person) before running the Review Wizard again. When you are finished adding 
authors, click Next. 

• Confirm the Document role and Person information, and click Finish. The new Title 
should now appear in the Resources tree view under Titles in the Reviews folder (try 
View > Refresh if it does not).  

 
As stated above, for now you also need to continue using the Titles Manager website to 
register new titles and check for potential duplicates. This is because some CRGs have not yet 
moved to Phase 2, and these Groups will still be using the Titles Manager website exclusively 
to register new titles. Thus, to check for potential duplicates across all CRGs, you will need to 
use the old website.   
 
We hope that Archie will replace the Titles Manager website entirely soon, but cannot yet 
provide a firm date. 

Creating a Vacant Title 

You may recall that, when you moved to Phase 2, Archie contained a number of Vacant Titles 
for your Group. These were Titles that had been registered on the Titles Manager website as 
of 14 February 2005 and imported into Archie. At the time these titles were imported, it was 
not possible to link them with an author or authors, so they were listed in Archie as Vacant 
Titles. One of the clean-up tasks you were asked to complete at the time of your move to 
Phase 2 was to assign a Contact author (mandatory) and Co-authors (if possible) to these 
records and to change their stage from Vacant Title to Title. 
 
Now that you have completed this clean-up task and are using Archie in your day-to-day 
work, you may want to create Vacant Titles to maintain a record of topics or titles that you 
hope will someday become reviews, but which have not yet been registered to specific 
authors. This might be a way, for example, of keeping a record of high-priority topics that 
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have not yet been covered by your Group. Similarly, you can use Vacant Titles for previously 
registered but now relinquished titles of important topics, or for keeping a record of informal 
contacts with potential authors. These usages are not, however, mandatory, and you may 
prefer not to use the stage Vacant Title at all. 
 
Note: If you have an inactive Protocol that you hope will become re-activated, you may 
consider having it listed as a Vacant Title. If the Protocol has previously been published, it is 
important that you do NOT simply set the stage back to Vacant Title, as this may cause errors 
in the review’s publication history. Instead, you should create a new Vacant Title, and contact 
you IMS support person, who can help you arrange having the two documents merged. 
 
Vacant Titles are created in the same way as Titles (File > New > Review), except that you 
choose Vacant Title on the opening screen of the Wizard and do not need to assign a Contact 
author or Co-author(s). 

Publishing reviews 

Overview 

As described above under ‘General principles’, publishing a document in Archie involves two 
steps:  1) first a user (in the case of reviews, typically the RGC) marks the document for 
publication using the Publication Wizard; and then 2) on regular quarterly submission 
deadlines, versions marked for publication are delivered to the publisher. 

Running the Publication Wizard 

Once all the necessary edits have been made, you can mark the latest version of a review for 
publication using the Publication Wizard (right-click on the title of the review and choose 
Publish). The Wizard lets you view the final version being marked for publication, and also 
allows you to compare it to the previously published version (using the View and Compare 
buttons on the opening screen). 
 
Notes:  
• In some cases you may not want to publish the latest version; for example, if you are 

republishing a previous version with updated contact details – see ‘When authors’ contact 
details are updated’, below.  

• A review must be in the Editorial phase before it can be marked for publication. The 
Publication Wizard provides you with the option of returning the review to the Authoring 
phase afterwards, and it is recommended that you do so. 

• The Publication Wizard will not allow you to publish a review that contains Errors. 
• See Appendix G for a detailed listing of the steps involved in marking a review for 

publication.  

Special cases 

When authors’ contact details are updated 
If an author’s contact details are updated in Archie, and you wish the change to be reflected in 
the author’s review, you must republish the review (Note that this currently only applies for 
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Contact authors, since only the name of the Co-authors is being published). If a later draft 
exists that is not ready for publication, you must: 

1. Revert to the latest published version. 
2. Mark the review for publication. 
3. Revert back to the latest draft version. 

 
Using multiple addresses for the same author 
Sometimes an author wants different addresses to be published in different reviews. As 
described above, authors are linked to reviews through Document roles, and this is also where 
you can choose which address to use for an author in relation to a specific review. 
 
To change the address used for an author in relation to a specific review: 

1. Go to the People tab of the review’s Properties. 
2. Highlight the relevant person and click Edit. 
3. In the Document role window, go to the Address tab, pick the relevant Address, and 

click OK. 
The chosen address is now the one that will be used for that review when you choose to 
update the contact details in the review in the Publication Wizard. 

Changes that require republishing 

In general, changes made to a review will only be reflected in the next issue of The Cochrane 
Library if the Publication Wizard is run again for that review. This is true for any change that 
is made by editing the review in RevMan (for example, correcting a reference or modifying 
the citation byline), and for most, but not all, changes made in Archie. 
 
The decision on whether a change to a review is important enough that an updated version of 
the review should be published as soon as possible, is one that should be made by the 
Editorial base on a case to case basis. To aid in this decision, the table below lists those 
changes made entirely within Archie (for example, by editing the review’s Properties) that 
could potentially require republishing.   
 
Change Republish? Notes 
Editing the review title Maybe If you want the title change to be published as 

soon as possible and do not need to make other 
edits to the current publication  

Modifying document 
roles 

Maybe If you have changed the review’s citation 
byline in RevMan 

Changes to contact 
author’s address 

Maybe Consider republishing if the changes 
significantly affect a reader’s ability to contact 
the author 

Changes to co-author’s 
address 

Maybe (low 
priority) 

The details for Co-authors are not currently 
being published 

Adding or removing a 
link to a topic 

No need The topics list is automatically published in its 
current state 

Changing review Status Required A Withdrawn review must be republished as 

Phase 2 User Guide    17 



Working with reviews in Archie 

from Active to 
Withdrawn  
 

such (after the reason for withdrawal has been 
added within RevMan) 

Changing review Status 
from Withdrawn to 
Inactive (protocols only) 
 

No need Inactive Protocols are automatically excluded 
from publication 

Editing the Next Stage 
Expected attribute 
 

Maybe If you want the change to be published as soon 
as possible and do not need to make other edits 
to the current publication 

Unpublishing reviews 

Unpublishing a review is not the same as withdrawing it, but simply a way of undoing a 
recent Publish action if done before the submission deadline. The Unpublish option is only 
available for reviews that have a version marked for publication and has the effect of 
removing the “For publication” status from that version. 
 
To Unpublish a review, right-click the review and choose Unpublish. Click OK in the 
confirmation message to complete the Unpublishing. 

Withdrawing reviews 

Full Reviews and Protocols can be published as withdrawn, which means that only the Cover 
sheet and Published notes are published. To withdraw a review: 

1. Edit the review, entering the reason for withdrawal in the Published notes. Check it 
back in to Archie. 

2. Withdraw the review by setting the Status to Withdrawn on the Advanced tab of 
Properties. 

3. Mark the review for publication using the Publication Wizard. It is important that 
you do this; otherwise the withdrawal has no effect on the publication. It also ensures 
that the version being published as withdrawn contains the withdrawal notice.  

Inactive reviews 

Withdrawn protocols need only be published for one issue. After that, their status can be set 
to Inactive (on the Advanced tab of the protocol’s Properties). Inactive protocols are 
automatically exempt from being published, so you cannot run the Publication Wizard for 
them. 
 
Reviews cannot be given the status Inactive, but your Group may have one or more reviews 
listed as Inactive in the Reviews folder of the Resources tree view. These are reviews that 
have previously been published but no longer are. They are kept in Archie to provide an 
accurate representation of your Groups’ publication history.  

Splitting and merging reviews 

It is planned that Archie will contain functionality that will make the process of splitting or 
merging reviews simpler. However, this functionality is not in place yet, and for now you 
should contact your IMS Support person who will help you out on a case-by-case basis.  
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Publication reports 

The are two Publication reports for your Group: 
• The Summary report, which lists 

o the total number of reviews and protocols being published; 
o the number of new, substantively updated, edited (which includes minor 

updates), commented, withdrawn, and unpublished reviews and protocols. 
o the title, byline, review number and date for each new, substantively updated, 

edited, commented and withdrawn review and protocol. 
• The Detailed report, which in addition to the above also lists the title, byline and date for 

all reviews and protocols. 
 
The way each category, for example, substantively updated, is defined, is described in the 
report. 
 
To open a publication report, right-click your Group in the Resources tree, and choose 
Reports > Publication Reports > Summary (or Detailed). 
  
By default, the publication report will be for the next issue of The Cochrane Library, but you 
can also see reports from previous issues, by choosing the issue from the pull-down list under 
the report heading. 
 
All reports are displayed in Archie’s document viewer, which among other things allows you 
to Download and Print the document. See ‘Viewing documents’ in Archie’s Help file for 
more details on the options. 

Review searches 

Archie’s Search function it not only useful for finding people, it can also be used to find 
reviews. One option is running simple searches that look in the title of all documents in 
Archie. You can do this by entering the text in the Quick search box at the top right and 
clicking the document icon, or pressing Ctrl +D. 
 
But you can also use the Advanced Search functions to search only within reviews using 
several of a review’s attributes, such as a person having a document role for it, or the date of 
last substantive update. To do so, go to the Advanced Search tab, and choose Documents. 
You can then pick the relevant fields to search on from the leftmost pull-down lists. See 
‘Advanced Search’ in the Help file for detailed guidance on this. 
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Using RevMan 4.3 in conjunction with Archie 
As stated above, one of the most important changes introduced by the new IMS is that you 
will now use RevMan only as a temporary space for working with reviews and not as a 
database for storing or tracking reviews. In terms of how RevMan is used for working with 
reviews, however, the new version of the program (4.3) functions very much like the version 
you are used to (4.2). The principal differences are: 

• RevMan 4.3 links to Archie so that you can check reviews out and back in to the 
central server. 

• When a review is checked back in to Archie, it is automatically removed from 
RevMan 4.3. 

• RevMan 4.3 has basic track changes functionality for editing the text of reviews. 
However, you are advised to use this with caution, see ‘Editing reviews’ below. 

 
Since RevMan should only be a temporary space for editing reviews, it is recommended that 
you do not keep reviews checked out to RevMan unless you are actively working on them.   

Installing the most recent version of RevMan 4.3 

If you are installing RevMan 4.3 for the first time, or if you installed the program long ago 
and have not updated since, you should make sure you are using the most recent version of 
RevMan 4.3, which is available at http://www.cc-ims.net/RevMan/RevMan4.3 (under “Latest 
version”). If you are installing RevMan 4.3 for the first time, you will need to install the Full 
version; if you are updating, you can run the Update patch. 
 
Note: Be sure to install RevMan 4.3 in a different directory than the one used for RevMan 4.2 
(you want to keep RevMan 4.2 as it is for now). Accepting the default location (c:\Program 
Files\RevMan43) suggested by the installation wizard should install RevMan 4.3 in its own 
directory. 

Connection to Archie 

The Archie connection settings can be viewed and edited in RevMan 4.3 by choosing Edit > 
Settings and clicking the Server tab. In daily usage, the URL for Archie (archie.cochrane.org) 
should be entered in the Server address field (the default when doing a fresh install of 
RevMan 4.3 is for it to connect to the test server - see below). You can add your Archie User 
name and Password to these settings if you want to avoid having to enter them each time you 
connect to the server. Enter these here only if you are the only person using your PC – 
otherwise another user of the PC could act in your name.  
 
Note:  you do not have to also open and log in to Archie to connect to it from RevMan, but 
you do need to have Internet access. 

Connection to the Training or Test server 

If you wish to experiment with the system without affecting your real data, or have been 
asked to test a new feature being developed, there are two other servers you can connect to:  
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• Training server - The Training server (training.archie.cochrane.org) is used by the IMS 
Support team for training purposes and by Phase 2 CRGs to try out Archie functionality 
without the risk of introducing mistakes in their live data. The Training server's 
functionality will usually match the live server's. 

• Test server - The Test server (test.archie.cochrane.org) is used by the IMS Development 
team and beta-testers to test new functionality before it is introduced on the live server. 
Generally, Phase 2 CRGs should not use the Test server unless they are helping to test 
new functionality that is to be introduced to the live server at a later stage. 

 
To connect temporarily to the Archie Training server rather than the live server, you can do 
this by choosing Edit > Settings in RevMan, clicking the Server tab, and choosing the URL 
for the Training server (training.archie.cochrane.org) in the Server address field. If you use a 
different User name and Password on the Training server, you will also need to edit these 
fields. Remember to edit these settings back to the live server when you are finished working 
on the Training server. 

Managing contact IDs and contact details in Phase 2 

Appendices C and D provide important information about managing contact IDs and contact 
details in Phase 2. Appendix C explains how contact details are used in Archie and in 
RevMan 4.3. Appendix D begins by describing a series of steps designed to prepare you for 
working with contact details and IDs in Phase 2 in the most efficient way possible. You 
should only have to complete these steps once. If you have not yet completed the steps 
described under ‘Set-up/Preparations’ in Appendix D, we recommend that you do this 
as soon as possible. The remainder of Appendix D describes procedures for dealing with 
contact IDs and contact details in your day-to-day work. Please familiarize yourself with 
these procedures now if you have not already done so.  

Checking out reviews 

As stated above, in the new IMS reviews are stored in Archie should only be checked out to 
RevMan for editing or exporting. The basic principles are: 

• You can only check out those reviews for which you have the proper permissions (for 
RGCs, this will normally be all Titles, Protocols, and Full Reviews in your Group). 

• You can only check out the most recent version of a review. To check out an earlier 
version, you need to revert to that version in Archie, then check it out. (On reverting 
to an earlier version, see above). 

• While a review is checked out to one user, it is not available to be checked out to any 
other user. But the user that has checked it out is allowed to check it out again (for 
example, in order to discard recent changes made in RevMan, or to check out the 
review to a different computer). 

• Every time you check out a review and check it back in, a new version is created in 
Archie. 

 
There are two ways of checking out reviews: within Archie and within RevMan. When you 
were initially introduced to the system, you were most likely told that you should only be 
checking reviews out from within RevMan, but the functionality for checking reviews out 
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from within Archie has been improved, and the two ways of doing this are now equally 
acceptable.       
 
To check out reviews within RevMan 4.3: 

• Choose File > Check out from server. 
• The Check out window will display all the Titles, Protocols, and Reviews you have 

permission to check out. Note that this also includes inactive Protocols and Reviews. 
By default, the reviews are listed in alphabetical order, but you can sort the list by one 
of the other attributes by double-clicking the column’s header.  

• Tick the Get box for the document(s) you want to check out and click OK. 
• Note that the review title includes the version number and description of the version 

checked out from Archie. 
 
To check out a single review within Archie: 

• Right-click the review and choose Check Out (XML format). 
• This lets you download the review as a .r4x file that can be opened by RevMan 4.3. 
• Click Open in the Download dialog to open the review in RevMan 4.3.  

  
See Appendix C for details on how contact IDs and contact details are handled when a review 
is checked out from Archie. 

Checking out reviews in Read Only (R/O) mode 

If you need to look at a review in RevMan, and know that you will not be making any 
changes that should be checked back in to Archie (for example, if you are just printing a PDF 
version), you can check out the review as Read Only. This way the review will still be 
available in Archie for checking out and editing by others. 
 
Checking out a review in Read Only mode requires that both the Get and the R/O columns are 
ticked. 
 
Read Only reviews are shown with a grey icon in RevMan (like secondary versions in 
RevMan 4.2), and cannot be checked in by most users. However, as Super User you can still 
check a Read Only review back in, but only if the review is not checked out by someone else 
at the time. 

Undoing a check-out 

You may have checked out a review to RevMan with the intention of modifying it, but then 
end up deciding not to make any changes right now. In such cases, the review should be 
returned to being available in Archie, which you can do by using the Undo Check-out option 
in Archie (from the review’s right-click menu). You should remember to also delete the 
review from RevMan 4.3. 

Editing reviews 

For editing reviews, RevMan 4.3 is very similar to RevMan 4.2. There are, however, a few 
differences:  
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• Version control features - if you try to edit a Read Only version you will get a warning 
that it cannot be submitted to the Group. Be aware that as Super User in your Group, you 
have extensive permissions and are allowed to override this and check in R/O versions in 
case important changes have accidentally been made to a R/O version. 

• Working copies - if you use the Copy review function in RevMan 4.3 it creates a 
Working copy that can be freely modified, but not checked in, even by Super Users. 
Working copies can, for example, be used to experiment with restructuring table of 
comparisons, but any edits that should be kept must be made in an active version.  

• Track changes - RevMan 4.3 has basic track changes functionality within the text of 
review. It can mark additions as green text, and deletions as green, strikethrough text. 
Track changes is initiated by clicking the Track changes button at the top of the review 
text editing window in RevMan. 
 
Note:  If you send a review with track changes formatting in it to somebody using 
RevMan 4.2, it will display the formatting, but not have any functionally for resolving the 
changes. Until clear guidance on how to use this functionality is prepared, we 
recommend that you do not use the Track changes feature in reviews being sent to 
authors.  

Checking in reviews 

Every time a review is checked in to Archie from RevMan, a new version of it is created in 
Archie. Depending on the type of check-in used (see below), the review may disappear from 
RevMan, and various actions may be triggered in Archie. 
 
Note: It is important to read the check-in report (see below) and take any necessary action. 
 
You can check in a single review by highlighting the review in the tree view in RevMan and 
using File > Check in single review; or by right-clicking the review title and choosing Check 
in. 
 
The three options when checking in a single review are:  
• Backup on server (keep review checked out) 

This function can be used to save a backup version to Archie, allowing you to continue 
working on the review in RevMan.   

• Check in draft (not ready for editorial approval) 
This is the equivalent of saving and closing a document in Word. It checks the review in 
to Archie, and removes it from RevMan, but does not affect the phase of the review. This 
is the option you should generally use for reviews being worked on within the CRG when 
they are in the Editorial phase. 

• Submit for editorial approval 
This is for final drafts from authors that should now be considered by the editorial base. If 
the review was in the Authoring phase, this will change the phase to Editorial.  

 
Tip: You must add a version description whenever you check in a review. To make it useful, 
keep it brief but descriptive. Remember that the date and person doing the check-in are 
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recorded automatically, so you do not need to include those. But if it is a version you have 
received from someone else, you should note that; for example, by including the initials. 

Check-in report 

Once the review has been checked in, RevMan will display a small report from Archie listing 
what actions were taken. You should check the report each time you have checked in a 
review, to see if there is a need for further action. You can use this list of ‘warning signs’ as a 
guide: 

• Review not found. New review created in [Entity] – this indicates that both the 
review ID and the title of the review have changed. You should edit the new version 
in RevMan (either by re-importing the .rm4 file from the authors, or by checking the 
newly created review back out) so that the title (or the ID) matches what is in Archie, 
and check the review in again. When you have successfully checked in the version to 
the correct review, delete the review that was created in error. Remind the authors to 
work on and return the correct version from now on.   

• The unique ID for this review ([ID]) did not match an ID in the system, but a 
match by title was found. The ID of the new version has been changed to match 
the ID in the system ([ID]) – the authors have submitted a version with a different 
ID. There is a risk that the authors have not worked on the version they should have – 
you can check this by comparing the versions. Remind the authors to work on and 
return the correct version from now on.   

• [Name]: Created – a new person record was created. This may be entirely correct, 
but if that author already had a record in Archie, but with a difference in the spelling 
of the name and email, Archie would be unable to match the two records, and would 
therefore have created a duplicate record. To check whether the person already had a 
record in Archie, run a Quick Search for part of the name (for example, the family 
name without any initials or suffixes). If there are now multiple records for the same 
person, mark your newly created record as a duplicate of the original (or, if there is 
no information in the new record that needs to be retained, simply delete it, and 
assign the relevant role(s) to the original record).  

[Name]: No action (differences found but ignored) – the contact details in the 
review were different from those in Archie, and have been modified more recen
could be that relevant changes have been made to a person’s contact details in 
RevMan, but Archie never automatically updates person records with data from 
RevMan. The contact details that were in the RevMan file are stored inside the 
version that was checked in, so you can compare the two sets of contact details by 
using View > Latest Version, a

• 
tly. It 

nd opening the person’s Properties, and positioning 

• 

ot 
e that your list of Authors is 

the two windows side by side. 

[Name] Contact author/Co-author document role created/removed - Document 
roles and Entity roles are not automatically correlated, so when a person that already 
exists in Archie becomes linked to a review, this does NOT mean that the person also 
will be given the Author role in your Group. If you think that the new author may n
have the Author role in your Group, and wish to ensur
continuously updated, check this on their Properties.  
Tip: if you do not wish to spend time verifying entity roles when you check in 
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reviews, you can instead choose to occasionally use Advanced Searches to corre
the Document and Entity roles. For example, if you search for persons with the 
Document role Contact author or Co-author in your group, Select All, and then se
for persons with the Entity role Author and Unselect All of those, your resulting 
selection will be those

late 

arch 

 authors that are linked to documents but do not yet have the 
Entity role assigned. 

 

useful at an early stage of the new IMS, but may be removed from RevMan 4.3 at some point. 

 
ws. This means that some special procedures are necessary when 

working with the system. 

•  versions of all 

review. 
• Documents should only be checked out when they are actively being edited. 

cedures 

Sen

5. ing phase, set this now to reflect the fact 
that the review now lies with the authors.  

Rec i
file into RevMan 4.3. 

2. Che i
a. 

ing Submit for editorial 

itted, 

 will have a record of the version the 

b. heck in as draft 
version – suggested description “Received from [initials]“ 

 

Checking in multiple reviews 

You can check in multiple reviews at the same time, but since you have fewer options when
doing this, we recommend that you avoid using this function. This feature was considered 

Exchanging reviews with authors 

It is important to note that although the new IMS has been designed to be used by both review 
authors and editorial bases, we are now in an ‘interim’ period where authors are not yet using
the system to manage revie

Summary of relevant principles 

Use Archie as your shared drive containing the latest (and previous)
reviews. Do not store reviews in RevMan.   

• Authoring / Editorial phase shows who should currently be working with the 

Recommended pro

ding to author 
1. Check out from Archie. 
2. Make any minor changes, if relevant. 
3. Export the review as .rm4 file and send it to the author. 
4. Check back in to Archie – suggested Description: “Sent to [initials]”. 

If the review was not already in the Author

 
eiv ng from author 
1. Import the received 

ck n to server: 
If author has sent a version for editorial consideration (and not for 
initial feedback on pre-editorial draft): Check in us
approval. This will change the phase to Editorial. 
Note: If there are errors in the version you received, it cannot be subm
and will instead have to be checked in as a draft, and then changed to 
Editorial phase in Archie. This way you
author considered ready for approval.  
If author has sent an unfinished draft they need help with: C
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Although RevMan 4.3 and Archie do not rely on the Contact IDs to correctly identity people, 
you will be exchanging reviews with authors using RevMan 4.2 where the Contact IDs are 
important. It is therefore recommended that you continue to maintain a consistent list of 
Contact IDs for you authors in RevMan 4.3. See Appendix D for details on how to do this.    

Exchanging reviews within the editorial base 

When you are working on reviews as part of the editorial approval, the review’s phase should 
be Editorial. If the phase is already correct, you and the rest of the editorial team should 
generally avoid using the ‘Submit for editorial approval’ option when checking the review in 
from RevMan 4.3. Using ‘Check in draft’ will not set the phase back to Authoring – this can 
only be done in Archie. 
 
You may choose to use the ‘Submit for editorial approval’ option instead, if you know that 
those of your colleagues who receive the message about the reviews being submitted wish to 
be notified in this manner (see ‘Messages ‘ below). 

Examples of current good practice 

Examples of the optimal use of the new system for registering a title, updating a review, and 
publishing a review are provided in Appendixes E, F, and G, respectively.   
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Working with the Module text 
With ModMan you prepared a single file, your ‘module’, for submission to The Cochrane 
Library. In Archie, your submission consists of several elements: 
• the reviews; 
• the module text; 
• the Group’s contact details (published as part of module text); 
• the sources of support (published as part of module text). 
• the topics list; 
 
The ‘Module’ document in Archie only contains the module text describing your Group, not 
the reviews or the topics list. Note that the module cover sheet and your Group’s Sources of 
support are edited separately from the module text. 

Editing the Module text 

Like reviews, the module text needs to be checked out when it is edited. However, since the 
module text is edited inside Archie, this happens seamlessly for the user editing it. But it is 
important to be aware of the underlying mechanism, because it means that while a module is 
checked out to one user, others cannot edit it. This is useful, but also means that it is 
important that the module is correctly returned to the Available status once you are done with 
it.  
 
Note: Simply closing the module editor window (using the X button) will NOT return the 
module to the available state. (This is due to a technical limitation in the way Internet 
browsers work.) You should always use one of the three disk buttons on the editor toolbar to 
save and/or exit the module editor. 
 
If a module has not been correctly checked back in, a Super User can use the Undo checkout 
function to restore it to the Available status. 
 
Tip: In the module editor, the Enter key creates a new paragraph, and the default formatting 
means that paragraphs are separated by blank space. You can insert a line break instead of a 
new paragraph, by pressing Shift-Enter.  
 
For details on using the module editor, see ‘Editing a module’ in the Archie Help file. 

Contact details used in the Module text 

Your module text includes your Group’s contact details. These are not duplicated as ordinary, 
editable text inside the Module, but are instead copied from the Group’s Properties. 
Note: This copying is not automatic, but only takes place when you run the Publication 
Wizard on the module text (see below), so you must republish the module to ensure that your 
updated details are included in The Cochrane Library.  
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Module byline 

To edit the byline included in your module text, go to the General tab of the module’s 
Properties, and click Edit under Citation byline. In the window for editing the byline, you can 
click Generate to insert a byline based on the people assigned to the module as Module 
editors. This list is generated alphabetically so may require editing. 

Sources of support 

Although published as part of your module text, the Sources of Support section is edited 
separately from the rest of the text. The list of sources of support is edited on the Support tab 
of your Group’s Properties. 
 
The Sources of Support list is automatically submitted in its current state on the submission 
deadline (like the Topics list). Unlike reviews and the Module text, there is no need to mark it 
for publication. 
 

Publishing the Module text 

Like reviews, the Module is marked for publication using the Publication Wizard. You should 
run this if you have prepared a new version of the module or wish to update the contact 
details being published for your Group (see above). 
 
To publish the latest version of your module text, right-click module document and choose 
Publish… This opens the Publication Wizard. On the first screen of the Wizard, you can view 
the version being prepared for publication as well as compare it to the last version published. 
The next page will show a validation report. If there are errors you will not be able to 
proceed, but you have the option of ignoring any warnings. On the final page there is a small 
publication checklist (the contents of which are under consideration), and the option to mark 
this as a substantive update of the module. 
 
See also ‘Publishing a module’ in the Help file. 
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Working with the Topics list  

Editing the Topics list 

Your CRGs Topics list is considered part of the CRG’s properties, and it can be found on the 
Topics tab of your Group’s Properties sheet. 
 
To add a new topic, click the heading you wish the topic to appear under, and click New. 
Enter a name for the topic and click OK. You may also include a Description, but this is 
entirely optional. 
 
You can also Edit an existing topic, or use the Up and Dn buttons to reorder the list by 
moving topics up or down. 
 
Reviews can be linked both from the Topics list (with the Link review button), and from the 
Topics tab of individual review’s Properties.       

Viewing the Topics list 

Your Topics list can be viewed as one of the Reports available for your Group. To do so, 
right-click your Group and choose Reports > Topics list. In addition to the usual options for 
the document viewer (see ‘Viewing documents’ in Archie’s Help file), the report itself also 
includes a number of options unique to the topics list, such as Show reviews, Show authors, 
and Show links to The Cochrane Library. 
 
When viewed in Archie, the list includes registered and vacant titles so it reflects what is in 
Archie, but when published it will only include the titles of published protocols and reviews. 

Publication of the Topics list 

On the submission deadline, your Topics list is automatically submitted in its current state. 
Unlike reviews and the Module text, there is no need to mark it for publication. 
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Preparing your quarterly submission to The 
Cochrane Library 

Checks 

Check all reports  

� Entity report (Right-click CRG name > Reports > Entity report) 
Everything up to (but not including) ‘Role summary’ in the Entity report will be 
published;  

� Topics list 
The Topics list will be published with the titles of all protocols and reviews marked for 
publication. Titles of Registered titles (T) and Vacant titles (V) will not be published. 

� Publication report 
Check number of published protocols and reviews in the Archie Publication report 
is as expected. You should investigate any discrepancies and resolve them before the 
module deadline. 
Tip: After marking a protocol or review for publication (see http://www.cc-
ims.net/Projects/newIMS/Training/Publishing-a-review.pdf ), check it appears in the 
correct section in the Archie Publication report rather than waiting for the module 
deadline.  

Check new publications 

� Check the Properties for all new publications to ensure that they are linked to your 
Topics list and the ‘Next Stage Expected’ is completed for protocols.  
Tip: Before marking a protocol or review for publication, check all the Properties and 
edit as appropriate rather than waiting for the module deadline. Even though this date is 
not currently published for reviews, we suggest that you do it for them too because there 
are plans to publish this date in the future. 

� Check to ensure that the protocol for a new review to be published in this module 
will no longer be published. 
There have been a few cases where this has happened because the title and the review 
number for the review released for publication were different from the protocol thereby 
creating two records for the same review in Archie. There are two ways to deal with such 
situations: withdraw the protocol, remembering to add the reason for withdrawal, and 
make it Inactive next time; or check out the review and change the unique ID for the 
review to that of the protocol before deleting the record for the review with the wrong ID 
from Archie (see the ‘Tips and Tricks for RGCs’ document for instructions on changing 
the ID). 

� Check that you have run the Publication wizard for your module text document. 
This will also ensure that any update to the CRG’s contact details will be published. This 
is similar to how you update contact details in reviews. 

� If you have activated a previously Inactive protocol because you now have an active 
draft in the editorial process, check that there is no version in the History that has 
previously been marked for publication. 
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If there is, it will be published because the record is now active. If you don’t want it to be 
published, we suggest keeping the protocol as Inactive until it is ready for publication or 
that you create a new record for the active version. (‘Inactive’ is therefore a publication 
status rather than a ‘working’ status.) 

 

Notes 

1. If you transfer a protocol or a review to another CRG, you must notify the publisher 
before the module deadline. Before doing this, you should contact your IMS Support 
person so that they can arrange for an IMS Developer to assist you. 

2. It is still possible to edit reviews after the module deadline but you will not be able to 
mark reviews for publication during the ‘locked period’, which is the three or four 
working days after the deadline during which time the submitted modules are 
processed and checked by Wiley. 

3. It is not necessary to run the Publication wizard when changing a protocol from 
Withdrawn to Inactive because the Inactive status automatically guarantees that the 
protocol will no longer be published and that no further action is required to ensure 
this. ‘Inactive’ is a publication status rather than a ‘working’ status. 

4. If you want to update contact details for a Contact author of a published review, you 
must run the Publication wizard. It is not necessary to do this for co-authors because 
their contact details are currently not published. 

5. If the by-line for the review is correct but you notice that one of the authors does not 
have a Document role in the review’s record in Archie, add the person to the People 
tab of the review’s Properties before running the Publication wizard. 

6. If you have marked a review for publication and then want to change the topic in the 
Topics list to which it is linked, you do not have to republish. 
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Messages 
The messaging system in Archie provides functions that are especially important for people 
who manage an entity, such as RGCs. 
The types of messages you can subscribe to are:   
• System messages - such as information about updates to the system.  
• Administration Messages, that notify you when: 

o duplicates have been marked that need resolving; 
o changes are suggested for persons in your entity; 
o a contact author of a published review in your Group is modified; 
o documents in your Group are submitted or approved. 

 
You can configure what messages you receive, and whether you wish to receive them via 
Archie’s messaging system or via email (see below). 
 
It is important that at least one Super User in each Group receives messages about duplicates 
and suggested changes and responds promptly to these. Not doing so can create considerable 
difficulties for other Groups. If you subscribe to messages via Archie’s messaging system, 
keep an eye out for the icon showing you that you have unread messages – see Figure 4.  

Figure 4. The unread messages icon 

  
Should you experience problems where another group does not react to suggested changes or 
duplicates that need resolving, please contact your IMS support person.   

Configuring messages 

You can change the settings for what messages you receive, and how. You can do this both 
for yourself and also for any people you have edit permissions for. To view or modify a 
person’s subscriptions, go to the Settings tab of Properties, and click Edit Notifications… to 
open the Notifications window. The possible subscriptions listed in this window are based on 
the person’s Entity Roles. Most persons can subscribe only to system messages and 
notifications about changes to their own record, but Super Users and RGCs have access to 
additional subscriptions. 
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Appendix A: Glossary of terms 
 
Document The special Cochrane documents where Archie ‘knows’ the content, i.e. is 

able to display or edit it. This includes reviews and the module text (and, 
later, entity web modules). 

Generic 
Documents 

Non-Cochrane documents (e.g. PDF or Excel files), that can be stored and 
shared in Archie. (Renaming these to ‘Files’ is under consideration). 

Version A specific version of a document.  
Review This covers all four stages of a review’s development. 
Vacant Title 
 

Review stage: A topic or title that a CRG hopes will become a review, but 
which has not yet been registered to a specific author or authors (not 
mandatory to use).  

Title Official acceptance of a review proposal by a CRG. The initial review stage. 
Protocol Review stage. See the Handbook for details on what sections are included in 

a Protocol. 
Full review Review stage. 
Module The Module document contains an entity’s module text. An Archie Module 

is different from a ModMan module: it is only the text, not the reviews and 
topics list. 

Entity roles Roles in relation to an entity, e.g. Author, or Staff. 
Document 
roles 

Roles in relation to a specific document, e.g. Contact author. 

Authoring 
phase 

Document phase where only Authors (and a Group’s Super Users) have 
access to the review. 

Editorial 
phase 

Document phase where only Editorial roles (and a Group’s Super Users) 
have access to the review. 

Shared Additional phase attribute for versions that have changed from Authoring to 
Editorial, or the opposite. Allows persons from both groups to view (but not 
check out) the version. 

Check in Check a document in to Archie. 
Check out Check a document out from Archie, e.g. to RevMan. 
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Appendix B: Document roles and associated 
permissions  
The table below shows the permissions associated with each type of Document Role. The top 
sections of the table show whether a role gives access in the Authoring or Editorial phase and 
what types of documents it is available for.  
 
  Co-

author 
Contact 
author 

Contact 
editor 

Copy 
editor Referee 

Module 
editor 

Role phase     
9 9  9 Authoring 

9 9 9  Editorial 
    

Document type   
  Generic Document 

9 9 9 9 9  Review Document 
 9 Module Document 
    

Permissions   
9 9 9 9 9 9 View* 
9 9 9 9 9 9 Read versions to be published 
9 9  9 Read author draft versions 

9 9 9 9 Read editorial draft versions 
9 9 9 9 9 9 Read shared draft versions 
9 9  9 Write during authoring phase 

9 9  9 Write during editorial phase 
9 9   View author roles 

9   Edit author roles 
9  9 View editor roles 
9  9 Edit editor roles 

 
* View permission allows a user to see a document in the Resources folder, and open its 
Properties. 
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Appendix C: How contact details are used in 
Archie and RevMan 
Although generally similar, Archie and RevMan also have some important differences in the 
way contact details and reviews are handled. In RevMan, the content of each review is unique 
– except for the contact details. These are shared across reviews, and if an author’s contact 
details are edited in RevMan, this will affect all reviews that the author is linked to. Archie 
also has a database of contact details, and, like in RevMan, each review is linked to a number 
of people in that database. But in Archie, each version of a review also includes the contact 
details that came with it. This ensures that when an RGC approves a review publication, it is 
published exactly as approved. If the contact details were merely linked instead of stored in 
the review, a CRG’s output could be modified after being approved in case another user 
updates the contact details of an author whose review is already marked for publication. 
Storing the contact details in reviews also means that the previously published versions of 
reviews that Archie stores are accurate snapshots of what was published.  

Figure C1. How reviews and contact details are stored in RevMan and Archie 

 

Within Archie 

When you compare review versions, the contact details stored in the two versions are also 
compared, which is useful in identifying changes between the two versions (but note that 
Archie may contain even newer contact details than those being compared in the reviews).  
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When publishing a review, Archie can either use the latest version of the review, which 
includes the contact details checked in from RevMan, or you can choose to update the review 
with the contact details currently in Archie before publishing.    

From Archie to RevMan 

When a review is checked out from Archie, the latest version of the contents of the review is 
combined with the current contact details of the authors, based on the current document roles 
for the review. The contact details stored within the review document in Archie are not 
passed back to RevMan.  

Figure C2. A review that is checked out from Archie consists of the latest 
document version combined with the current contact details of the authors 

 

How RevMan 4.3 assigns contact IDs 

When a review is checked out from Archie, one of two things can happen for each author 
associated with the review: 
• If the author has a Contact ID in Archie AND the CRG owning the review is that 

person's Primary Entity:  
The Contact ID is passed on to RevMan, and RevMan tries to match on Contact ID before 
name and email.  

• If the author has no Contact ID in Archie, OR  
• If the author does not have that CRG as their Primary Entity 

RevMan is not supplied with a Contact ID and therefore matches on name and email. If 
no match is found, a new record is created, with an auto-generated unique ID in the 
format [Initials][two-digit number], eg BH01. 
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From RevMan to Archie 

Contact details are primarily transferred to Archie from RevMan as part of the review Cover 
sheet – i.e. inside the review document. The contact details in the review being checked in are 
compared against the information in Archie’s database, but generally, RevMan 4.3 does NOT 
update any contact details in Archie. However, if an author has been removed from or added 
to the review in RevMan, Archie will update the relevant document roles. Entity roles are not 
updated for persons that already exist in Archie data. The one exception is if the new author 
does not already have a record in Archie, in which case a new record is created, and given the 
entity role Author. 
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Appendix D: Managing Contact IDs and 
Contact Details 

Set-up/preparations 

1. Clean up contact details in Archie as described in the Phase 1 User Guide. Specifically, 
make sure that all your Group’s authors have a record in Archie, that they have been 
assigned the Entity role ‘Author’ in your Group, and that their most up-to-date contact 
information is in Archie. In cases where you are not the Primary Entity, use Suggest 
changes to inform the Primary Entity of any edits that need to be made.  

2. Remove any reviews currently in RevMan 4.3 (by checking in to Archie, or exporting and 
deleting). 

3. Delete all contact details in RevMan 4.3 except your own (which cannot be deleted). To 
do this, go to Action > Compact and repair database and click Yes when you are asked 
whether you want to delete contacts that are not linked to a review. Use View > Show 
reviewers to confirm that yours is the only contact record left. 

4. In Archie run an Advanced Search for all Authors in your CRG (Role in entity / Author / 
in [your CRG]). Select the records identified and export them (Tools > Export and 
Labels) in RevMan/HIREx format.  

5. In RevMan 4.3 import the contact details exported above (File > Import > Contact 
details). 

6. Using the View > Show reviewers tree view in RevMan 4.3, check and, if necessary, edit 
the contact IDs brought into RevMan to match your list of unique IDs for your CRG. 
[Tip: To do this, either print off your CRG’s list of contact IDs or, if you have maintained 
them in RevMan 4.2, print them off from there (View > Show reviewers, then File > Print 
tree view) and compare them to the list (View > Show reviewers) brought into RevMan 
4.3 from Archie.] Make any corrections that are needed in RevMan 4.3. 

Contact IDs 

Once you have completed the steps described above, you should be able to forget about 
contact IDs, which are not used for publication in Phase 2. When you add a new author to 
Archie (for example, in connection with a title registration), there is no need to enter a contact 
ID in Archie. An ID unique to your Group will be created within RevMan 4.3 the first time 
you check out a file containing the new author’s contact details from Archie.  
 
Until review authors move over to using the new IMS, they may still send you RevMan files 
in which they use contact IDs that are not the ones assigned in your Group. The 
review/contact detail import routine in RevMan 4.3 should protect against the creation of 
duplicate records with two IDs, provided you do NOT choose the option to “Use the new 
information with the new Contact ID” on the contact details comparison screen. If you try to 
import contact details with an ID already assigned in RevMan 4.3, you will be alerted to this 
and will be able to assign a new ID to the incoming details. 
 
Using this system, the View > Show reviewers tree view in RevMan 4.3 should display a list 
of all the authors in your Group, with the contact IDs assigned to them in your Group.  
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Contact details 

When importing an rm4 file from outside the system into RevMan 4.3 

You will get a comparison screen showing any discrepancies between contact details in the 
incoming file and those stored in RevMan 4.3 (imported from Archie). Choose the most 
complete and up-to-date details, making a note of any cases where the details in the incoming 
rm4 file are better than those in RevMan 4.3/Archie (just noting the name, not the detailed 
discrepancies). [Tip: Remember that authors often send RevMan files containing out-of-date 
or incorrect contact information. Do not assume that information in the import file is correct.] 

When checking an rm4 file into Archie 

At the end of the check-in procedure, note what the check-in report says about discrepancies 
between contact details in Archie and those in the file you've just checked in. [Note:  By 
“check-in report”, we mean the little grey window that pops up at the end of the check-in 
routine informing you of actions taken vis-à-vis contact details, document roles, etc. It is a 
current wish list item that this window be printable; for now, you will need to make notes 
separately.] 
 
After check-in, and within Archie, investigate any discrepancies in contact details noted in the 
check-in report. To do this:  
1. In the Resources tree view, right-click the review you just checked in and choose View > 

Latest version. 
2. Within the viewing window, choose the “Full text view” (upper left, pull-down menu), 

which will display contact details for the contact author and co-authors on the Cover 
sheet; minimize the viewing window.  

3. Search for the record of the person whose details you need to check (using Quick Search 
or by scrolling through the Resources tree view); open their Properties.  

4. Maximize the review viewing window, navigate to the Cover sheet/contact details 
section, and compare the details there with those in the person’s Properties, side-by-side, 
line-by-line, and make edits if necessary to the person’s Properties. The revised contact 
details will be picked up and attached to the review the next time you check it out from 
Archie. Remember that contact details should always be edited in Archie, not in 
RevMan. Use Suggest changes where you are not able to edit a record directly. 

When marking a review for publication 

You should normally choose the option (on the first screen of the Publication Wizard) to 
include contact details from the contact database (Archie) in the published review. The only 
exceptions would be a few special cases, for example, if you discovered at the last moment 
that another Primary Entity had not been able to correct an address for one of your authors 
that you knew to be out of date, or to add a secondary address you wanted to use for 
publication. (See the Phase 2 User’s Guide for discussion of such exceptions.)  Remember 
that you can always use the View button in the Publication Wizard to confirm that the contact 
details you are about to publish are correct. 
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Appendix E: Steps in registering a Title 

1. Upon receiving a title registration form (or email enquiry with details of a new 
proposal), check if the person already has a record in Archie by doing a Quick 
Search. If the person exists in Archie, add Entity role ‘Possible contributor (Author)’ 
in your CRG. If the person doesn’t exist, create a record and assign the person the 
Entity role ‘Possible contributor (Author) within your CRG. Create a Vacant Title 
using the Review Wizard. 

2. Follow your Group’s existing procedures for processing and approving proposed 
titles. 

3. Once the title has been approved, view the Properties tabs and register the title by 
changing the stage to ‘Title’; add co-authors if not previously known; update the 
person’s Entity role from ‘Possible contributor (author)’ to ‘Author’; link to Topics 
list if possible; enter issue protocol expected to be published; and update Notes if 
necessary. Phase should be Editorial (indicating that the Title now ‘sits’ with the 
editorial base). 

4. Check Title out from Archie to RevMan 4.3.  

5. Prepare the Coversheet for the Review in RevMan 4.3, i.e., remove the version label 
(the version number cannot be deleted in RevMan 4.3 but will not transfer to RevMan 
4.2); change from Title to Protocol in RevMan; add Review ID; add Date next stage 
expected given by author on title registration form. 

6. Consider adding any ‘standard text’ used by your CRG to the appropriate sections of 
the RevMan text. 

7. Export the prepared RevMan file before checking it in to Archie as ‘Check in draft 
(not ready for editorial approval)’ with a clear Description (for example, ‘RGC sent 
to [author’s initials]’).  This will keep the title listed under Titles in Archie.  Set the 
Phase to Authoring (indicating that file now ‘sits’ with authors). 

8. Send the exported .rm4 file to the Contact author and ask the author to use it to 
develop the Protocol. 
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Appendix F: Steps in receiving an update to a 
published review 

In advance: 

• Encourage Contact authors to ask you for the RevMan file to use to update their 
reviews. 

• Check the review to be updated out of Archie, remove version label, export from 
RevMan and ‘Undo checkout’ in Archie OR check back in to Archie with the 
Description ‘Sent to [author’s initials]’. 

When the review is received: 

1. Save the updated RevMan file sent by the author to the appropriate folder on your 
PC. 

2. Open RevMan 4.3 and Import the RevMan file. 

Note: Contact ID and contact details will be recognised if you imported your authors’ 
contact information from Archie when you first installed RevMan 4.3. 

3. Use File > Check review to identify if it contains Errors. 

4. Check in to Archie with a clear Description (for example, ‘Received from [contact 
author’s initials]’). 

Tip: Always check in author’s draft before editing so that you have a record of the 
version submitted by the author. 

(a) If  no Errors identified: check in ‘Submit for editorial approval’, which will 
change the Phase automatically to Editorial. 

(b) If  Errors identified: check draft in as ‘Check in draft (not ready for editorial 
approval)’ and change Phase to Editorial in Archie. 

Notes: (i) If the review is not the Primary version but you still want to check it in to 
Archie, you will have to check it in as ‘Check in draft (not ready for editorial 
approval)’ and change the Phase to Editorial. (ii) If the author has not used the 
published RevMan file, it will not be recognised in Archie and will create a duplicate 
record. Contact your IMS support person if this happens. 

5. View the report produced in RevMan when the review has been successfully checked 
in and note any information that has been updated or ignored and needs to be checked 
in Archie, for example, Document roles and Entity roles that have been created or 
deleted, or discrepancies in contact details. 

Tip: Currently you cannot print the check-in report, but pressing Alt + Print Screen 
will copy a screenshot of the active window, which you can paste into Word and then 
print out.    
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6. 
g publication to identify differences, including differences 

7. tact details need to be updated, make the necessary edits in Archie so that the 
ut 

s don’t 
 

8. SC and the Contact Editor a Document role for the Review so that they can 

 to edit the new draft; (b) 

9. need to edit the review, check it out from Archie, edit in RevMan, and 

otes; 

g it back in to Archie (with a clear 
Description, for example, ‘RGC sent to [contact author’s initials]’) because it will 
now be removed from RevMan on check in. 

Go to the Properties for the review in Archie: Properties > History and ‘Compare’ the 
new draft with the existin
between the currently published contact details and the contact details in the 
submitted RevMan file. 

If con
next time you check out the review, the correct contact details will be checked o
too. 

Notes: (a) If you don’t have permission to edit the contact details, use Suggest 
changes to alert the Primary Entity to changes that need to be made; (b) author
generally pay much attention to their contact details in RevMan so they may not be
the most up-to-date; (c) you can compare the contact details stored within the 
submitted review with those in Archie by opening the General tab of the person’s 
Properties and placing it next to the Contact details section in the View for the 
document and, if necessary, edit the details in Archie; (d) you will be able to check 
the set of contact details you wish to publish when you run the Publication Wizard. 

Tip: Remember you can access the authors’ contact details from the People tab in the 
Review Properties. 

Give the T
view and edit the draft according to your CRG’s internal procedure for processing 
updates.   

Notes: (a) RGC to email/tell them when they want them
they can check out and make edits in RevMan and check back in; agree a clear 
Description (for example, ‘Edited by TSC’) with them. 

When you 
check it back in to Archie with a clear Description (for example, ‘Edited by [your 
initials]’). 

Tip: Remember to review and add any relevant information to the Properties > N
for example, you can copy and paste email messages into Notes. 

When returning an edited version of the review as a RevMan file to the author, 
‘Export’ it from RevMan first before checkin
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Appendix G: Steps in publishing a review 

Prerequisite: Review in Archie approved for publication. 

1. Check out to RevMan 4.3.   

2. Do any final copy editing needed.  

Note: Remember to check the Cover sheet in RevMan to make sure the “Date of most 
recent substantive amendment” has been set correctly (i.e., has been set so as to 
generate the correct citation in the Wiley system). 

3. Export as .rm4 file and prepare PDF file of Licence for Publication form before 
checking review back into Archie.  

4. Send RevMan file and Licence for Publication form to authors, asking them to 
approve the copy-edited version within a suitable timeframe (could be 24/48 hours) 
emphasising that the review will not be published if they don’t fax the form back 
within this timescale, i.e., you must have signed forms before you can release for 
publication. 

Note: tell them not to send the fax to the number on the form but give them your fax 
number in the email message. 

5. When you have approval, check all tabs in the review’s Properties in Archie: General: 
Phase set to Editorial? 
People: Document roles correctly assigned? 
Note: You can publish a secondary address for an author, if necessary. 
Topics: Linked to Topics list 
Advanced: Status and Next stage expected 
History: Compare for further reassurance! 

6. Right-click the review in Resources tree view and choose Publish. 
Check box to take contact details from Archie (even if you want to publish a 
secondary address [see Note to 5. People, above]). 

7. Click ‘View’ to confirm that contact details are correct. 

8. Click ‘Next’ – check box if you want to ignore warnings. 

9. Click ‘Next’ only if you have the signed Licence for Publication forms 

10. Check the box for returning the review to the Authoring phase. 

11. Click Publish, then Done. 

 

See also ‘Preparing your quarterly submission to The Cochrane Library ‘, above. 


